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ADMINISTRIVIA 
TA: 

 Kristen Jaskie   cs3fa1@ieng6.ucsd.edu 

Home page for the course  

http://www.cse.ucsd.edu/users/ricko/CSE3 

Bookmark it! 

Lab Policy 

Attend the lab you are enrolled in!  

Make sure you get checked off BEFORE you leave each week!!! 

We WILL begin lab on time.  Lateness will not be tolerated.  We will ask you to  

leave if you are more than five minutes late. 

Missed Lab Policy:  

 There are NO makeup labs or changing lab section without professor 

approval. 

If you miss a lab, you must make it up before your next scheduled lab. 

Grading 

9 labs, 45% of your grade overall.   

1/2 credit for the lab itself, 1/2 for the homeworks. 

All or nothing grading on each part. 

 

 

A. Enabling file extensions in Windows Explorer 
Windows, by default, will hide file extensions that are known. It is meant to be a 

convenience, but it is actually confusing and dangerous. It is dangerous because you may 

receive a file "essay.doc", but if you are unaware your extensions are hidden, it could 

really be a "essay.doc.exe" file and contain a computer virus.  We will now fix that. 

 

Step 2:   

Double click on My Documents on the desktop and go to  

Tools -> Folder Options. 

 

Step 3:   
Click the "View" menu item. 

 

Step 4:   
Look for "Hide extensions for known file types" and make sure the box is 

UNCHECKED. Then click "Apply to all folders" at the top. Then click "OK". 

Lab 1 
CSE 3, Fall 2009 

In this lab you will create a basic homepage and put it up online.  You 

will then work on the Scratch program introduced in lecture. 
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B. Find and BOOKMARK the class homepage 
To start with, we want to go to the class homepage.  There are two common web 

browsers installed on your lab computers: 

1) Microsoft Internet Explorer 

2) Mozilla Firefox 

 

These browsers are similar to use but have slightly different key words and menu names.  

For simplicity, during this class we recommend that you: 

ALWAYS USE MOZILLA FIREFOX 

 

Step 1: 

Let’s start by opening Firefox now.  There are two ways to do this: 

1) You can click on the icon on the desktop or 

2) You can click on the Start menu on the bottom left side of your screen and 

choose All Programs and find Mozilla Firefox on the menu that pops up. 

 

Step 2: 

Once you have Firefox open, type the address given below into the address bar at the top 

of the screen: 

http://www.cse.ucsd.edu/users/ricko/CSE3 

 

Step 3: 

Now go to the Bookmarks menu and select Bookmark This Page.  You can name your 

bookmark whatever you like ("CSE3 Homepage" for example) and click OK.   

 

C. Create a HOMEPAGE 
This quarter, you will learn to make web pages using html and JavaScript.  Today we’re 

going to start you off by creating a basic home page that we will then put online.  Don’t 

worry if you don’t understand everything that your TA is talking about – you will later.  

Just follow along and have fun! 

 

Step 1: 

Let’s start by going to the Start menu on the bottom left-hand side of your screen, select 

All Programs and choose Notepad++. 

 

Step 2: 
ALWAYS, ALWAYS, ALWAYS save your document FIRST!  Go to File => Save.   

Save your file IN your My Documents folder (you will have to navigate to it) 

Save your file as index.html with a LOWERCASE i 

Make sure you include the extension .html otherwise it won’t work 
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Step 3: 
Now for the fun part.  You want to follow your TA as they create a basic html skeleton: 
 <html> 

  <head> 

   <title></title> 

  </head> 

  <body> 

 

  </body> 

 </html> 

 

Step 4: 

Put your name inside the <title></title> tags, this will be what shows up in the 

blue bar at the very top of the window 

 

Step 5: 
Inside the <body> tag, we are going to add an attribute to change the background color of 

the page.  This will look like: 

 
 <body bgcolor="red"> 

 

if you want a red background color, or you can use whatever color you want.  Make sure 

you use double quotations around the color name! 

 

Step 6: 

Now, in between the <body></body> tags, we’re going to put some information about 

YOU! 

 

Step 7: 
First, let’s make sure that everything is centered on our webpage.  Inside the 

<body></body> tags and indented, we are going to put <center></center> tags. 

 

Step 8: 

Now, inside the <center></center> tags, write your name inside <h1></h1> tags 

(that’s the number 1, not the letter l).  If your name were Susan Smith, this would look 

like: 
<h1>Susan Smith</h1> 

or 
<h1>Susan’s UCSD Career</h1> 

 

 

Step 9: 
Let’s add a picture to your webpage.  At the end of this course, you will have created a 

web page that can be your showpiece at the career fair or for your graduate 

program committee.  Thus your picture for Lab#1 on your home page should be 

representative either of yourself, your major, or your career.   
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This can be a picture of you off of your Myspace or Facebook page, or any picture that 

represents your major or planned career off of the internet.  Take a few minutes to find 

such a picture.  When you’ve found a picture you like, you need to RIGHT CLICK ON 

IT and click Save Image As.  Do NOT try to copy the pic.  Save the image into your My 

Documents folder as  

 HomepagePic.jpg or HomepagePic.gif 

 

Step 10: 
To put the picture into your webpage, you need to add the line: 
  

 <br /> <img src="HomepagePic.jpg" /> <br /> 

or 
 <br /> <img src="HomepagePic.gif" /> <br /> 

 

Underneath your name from Step 8.   

 

If your picture is TOO BIG, include the attribute width="300" inside the image tag.  

Like this: 
 <br /> <img src="HomepagePic.jpg" width="300"/> <br /> 

 

You don’t need to also specify the height, since this will automatically scale your image. 

 

Step 11: 
Finally, you might want to include some information about yourself and your major.  Use 

BREAKS (<br />) to separate lines of text. 

• Add a line of text underneath your picture describing in one sentence your school 

or career goals.  Some examples:  

o “I am a Biology major at UCSD and hope to work in the Biotech 

industry.”  

o “I am a Psychology junior at UCSD and plan on getting my Master’s in 

Social Work so I can help people.” 

• Add a couple of lines that say something about your coursework.  It can be your 

current quarter’s classes or some of the important classes that you’ve taken so far. 

o Include CSE 3 in your list. 

o Ex:  

Fall 2009 Coursework 

 Psych 101 

 Bio 101 

 CSE 3 

 

So far, your webpage should look something like this: 
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Step 12 
Looks very nice so far, but let’s make it look a little more professional using tables. 

 

• Underneath your Title/Header from Step 8, write (use whatever color you want): 
o <table  border="2" bgcolor="lightgreen"> <tr> 

• Just above your </center> closing tag, write: 

o </tr> </table> 

• You have just specified that you want a table with one row (the <tr> tag) 

• Lets add two columns by wrapping your image and text with <td></td>  tags: 
o <td><img src="HomepagePic.jpg"></td> 

o <td align="center"> 

Text info from step 11 goes here. 
</td> 

 

 

 

 

Step 4 

Step 8 

Step 10 

Step 11 

Step 5 
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Your final Webpage should look something like this: 

 

 
 

 

By the end of this course, you will have the skills to modify your webpage to make it 

look just about any way that you can imagine.  Think of this as a preview. 

 

D. Creating a Personal Website - Administrative 
The html document that we just created is not yet on the web.  It is just a file inside your 

My Documents folder.  Nobody other than you can see it right now.  You have to be 

logged into your account on a campus computer to see it. 

 

In order to put our file onto the internet, we need to first configure our account so that we 

have a place to put it on the internet. 

 

Step 0:  

Go to https://sdacs.ucsd.edu/~icc and determine your UCSD campus wide account name 

and email server, if you don’t know it already.  Your account should be your email 

address without the @ucsd.edu part.  

 

Step 1:   
Go to the ACS website http://acs.ucsd.edu and click " Students" on the top menu bar. 

 

Step 2:   

In the blue box on the right-hand side of your screen, select "Websites & Sharing Files" 
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Step 3:   
Choose "Setting up a personal website" (second link down). 

 

Step 4:   
Click "Home Page setup tool" (the first link AFTER the bulleted list) 

 

Step 5:   
Once you are on this page, you should see:  

Two text boxes  

 Username – enter your UCSD email address without the @ucsd.edu part 

 Password – enter your email password 

A drop down box for your server – choose your email server 

 IF YOU WERE ASSIGNED "sdcc13", "sdcc15", "sdcc17", or "sdcc21",  

  choose "acsweb" to be your server.  All other servers ("ieng6" or "ieng9"  

  for example) stay the same. 

Two checkboxes – you want to check both of these 

Then hit continue. 

 

Step 6:   
It will take some time to setup your account so be patient.  When it is done, it will give 

you the link to your homepage, which you should bookmark in your web browser now, 

just like we did for the class homepage in section A.  You’ll notice it’s not very 

interesting yet! 

 

E.  Putting your Homepage up on the Web 
Now that the server is setup, we can transfer files using "SSH Secure File Transfer 

Client".  This will actually put the files on the internet so that everybody in the world can 

see them.  We will be doing this at the end of EVERY LAB AND you will be tested on 

the procedure, so you need to remember how it works! 

 

Step 1:   
Start the program Secure File Transfer Client.  Go to: 

Start => All Programs => SSH Secure Shell => Secure File Transfer Client 

 

Step 2:   
Click "Quick Connect" near the upper left. (Ignore the error if you see one).  

A box will popup asking for your "Host Name" and "User Name".   

Your host name is your (email) server name (acsweb or ieng6 for example) 

Your user name is your UCSD email address without the @ucsd.edu part.  

Write these into the box above for future reference in case you forget. 

 

Step 3:   
Click "Connect" (It may ask for verifying a key. Just click OK when you see this.  If you 

see some other odd messages, just click OK.)   

It will then prompt for a password.  Go ahead and enter it. 
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Step 4:   
Once logged in you will see two panels.   

The left side shows your local computer. 

The right side shows the web server.    

For most of the labs we will be transferring from your computer to the web server, which 

means you want to drag from left to right.   

The left panel shows your desktop contents initially, and the right side just shows 

"public_html".  

Double click "My Documents" on the left, and "public_html" on the right.   

You should now see white empty space on the right or a single directory "CSE3". 

 

Step 5:   
Click and drag your index.html and Homepage.jpg files from the left panel to the 

WHITE SPACE in the right panel.   

 

NEVER EVER EVER DRAG INTO A DIRECTORY IN THE RIGHT PANEL.  Always 

drag a file, a set of files, or a directory into WHITESPACE on the right. 

 

Step 6: 
Finally, lets go check it out online!   

Open up Firefox and open up your bookmark for your homepage.  If you didn’t 

bookmark it in Section C, the address should be: 

 

 http://acsweb/~[ user name ] 
 
(if you have an ieng account, use that instead of acsweb). 
 

NOTICE: 
You now have TWO copies of your webpage. 

 One on your LOCAL COMPUTER and 

 One on the internet 

These are copies of one another, but they are NOT the same file!!! 

 

Step 6: 

Make sure you get your lab checked off before going any further.  Your Professor will 

help you get started on your scratch assignment, but it is homework, and you will not be 

able to finish it before the TA’s leave, so you want to make sure you get credit for Lab 1 

before you begin. 
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F. Scratch Homework 
 

Each lab will have a homework assignment associated with it.   

• AFTER you get your lab checked off, you are welcome to work on the homework 

for the rest of the lab time.   

• You can use any of the labs in the basement of the ACS building to work on your 

homework as long as there is not a class present at the time. 

• Your homework will be checked off just like your lab AT THE BEGINNING OF 

THE FOLLOWING LAB.  If you are more than 5 minutes late to lab, you will not 

get credit for the homework. 

• Homework is worth 50% of your lab grade - it's definitely worth doing. 

• Scratch is installed on all the CSE basement lab systems. Or you can install 

Scratch on your own system and demo the Homework to us on your system. 

 

Step 1: 
You can find your current homework assignment on the class webpage at: 

 http://cseweb.ucsd.edu/users/ricko/CSE3/.... 

 

G. Setting Up Scratch - OPTIONAL 
The computers in the lab all have Scratch already installed.  If you want to set it up on 

your home computer as well to make your homework easier, follow these instructions: 

 

Step 1: 
Go to http://scratch.mit.edu 

 

Step 2: 

At the very top of the page, click on the “support” option in the blue bar. 

Next, click on the “See How to Get Started” option on the left-hand side of your screen. 

Finally, choose to download “Scratch Software” (Option 1) 

 

Step 3: 
You can download either a Mac OSX version or a Windows version here. 

 

H. Miscellaneous Administrative Tasks - OPTIONAL 
 

PRINTING on campus 
When you are logged onto a campus computer, you can print files if you set up an 

account on the ACS network.  It does cost money to print on campus.  This section is 

optional and you can do it on your own time if you are interested. 

  

Step 1: Go to http://acs.ucsd.edu/students/#print  

 

Step 2: Click on "Printing Account" halfway down the page 

 

Step 3: Follow the instructions given if you would like to set up or print from campus. 
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Check Off: 
 

LAB: 

To receive credit for this lab you need to show your TA your homepage ONLINE, not the 

copy in your My Documents folder.   

• You need to have: 

o Title bar 

o Page Heading 

o Background color 

o Image 

o Table with at least 2 cells 

o Text, including some of the classes you have taken/are taking 

� Including CSE3 

 

Do not leave until you have seen a TA mark your name down.   

It is your responsibility to make sure you get credit for each lab! 

 

HOMEWORK: 

To receive credit for your homework: 

• You need to complete the Scratch project from the class homepage (specified in 

section F, step 1 above) on your own time. 

• You must get the homework checked off within the first FIVE MINUTES of the 

following lab by a TA.  If you are late, you will get partial credit or no credit. 


